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1 About this manual
Welcome to Telelogic® DOORS for Serena Version Manager Interface™.
Telelogic DOORS for Serena Version Manager Interface transfers data between 
Telelogic® DOORS® (DOORS) and Serena® Version Manager™. It allows 
complete lifecycle traceability from requirements through to configuration 
management.
This manual describes how to use version 1.4 of Telelogic DOORS for Serena 
Version Manager Interface. It assumes that you know how to use both DOORS 
and Serena Version Manager.

Typographical conventions
The following typographical conventions are used in this manual:

Related documentation
The following table describes where to find information in the documentation 
set:

Typeface or 
Symbol

Meaning

Bold Book titles, important items, and items that you can select, 
including buttons and menus. For example: Click Yes to 
continue.

Courier Commands, files, and directories; computer output. For 
example: Edit your .properties file.

> A menu choice. For example: Select File > Open. This means 
select the File menu, then select the Open command from it.

For information on See

How to use Telelogic DOORS The Telelogic DOORS documentation 
set

How to use Serena Version Manager The Serena Version Manager 
documentation set 
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You’ll find PDF versions of the DOORS manuals on:

• The Telelogic Lifecycle Solutions DVD

• The support website at https://www.support.telelogic.com

What’s new in Telelogic DOORS for 
Serena Version Manager Interface 1.4

The Telelogic DOORS for Serena 
Version Manager Interface readme file

How to install Telelogic DOORS for 
Serena Version Manager Interface 

Telelogic DOORS Installation Guide

How to set up licenses to use Telelogic 
DOORS for Serena Version Manager 
Interface 

Telelogic Lifecycle Solutions Licensing 
Guide

For information on See
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Related documentation
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2 Concepts
This chapter introduces Serena Version Manager Integration and explains the 
concepts you need to understand before using it:

• About Telelogic DOORS for Serena Version Manager Interface

• About Telelogic DOORS for Serena Version Manager Interface functions

About Telelogic DOORS for Serena Version Manager Interface
DOORS is the world’s leading tool for creating, structuring and managing 
complex sets of requirements, such as those for a typical software development 
project. Serena Version Manager from MERANT Solutions, Inc. is a widely used 
source code control system.
Telelogic DOORS for Serena Version Manager Interface is a bridge between 
these two products, enabling complete lifecycle traceability from requirements 
through configuration management.
Telelogic DOORS for Serena Version Manager Interface allows software project 
teams to:

• Establish traceability from DOORS information to specific files, folders or 
file revisions in Serena Version Manager.

• Import release label information from Serena Version Manager to DOORS.

• Import promotion group information from Serena Version Manager to 
DOORS.

• Create DOORS baselines to match Serena Version Manager version labels.

• Generate complete reports on combined Serena Version Manager and 
DOORS configuration status.

About Telelogic DOORS for Serena Version Manager Interface 
functions

Telelogic DOORS for Serena Version Manager Interface provides two functions 
that are fundamental to integrating configuration management with lifecycle 
traceability:

• The ability to represent the configuration item structure stored in Serena 
Version Manager as a DOORS module.
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In this operation, each folder, file and revision in the selected project is 
represented by a DOORS object in a hierarchy that represents the complete 
version tree for that project.

Once you have replicated the Serena Version Manager configuration item 
structure in a DOORS module, you can use normal DOORS link functions 
to establish traceability from project information stored in DOORS to the 
configuration items.

For example, a Serena Version Manager version object that implements a 
specific requirement can be directly linked to the corresponding DOORS 
requirement object. This allows you to demonstrate conformance to 
requirements at source-code level.

• The ability to baseline DOORS modules using the same version labels as the 
Serena Version Manager data.

This operation uses another DOORS module to store a list of labels that 
exist in each project, and to create baselines automatically for groups of 
modules. Each baseline is recorded in the DOORS module, providing a 
configuration management record of which DOORS baselines relate to 
which Serena Version Manager labels. This function also provides the ability 
to create baselines for many DOORS modules simultaneously.

These two functions create a unified approach to both traceability and 
information release control, resulting in full lifecycle traceability and rigorous 
configuration management.
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3 Importing from Serena Version Manager
This chapter describes: 

• Importing from Serena Version Manager to DOORS

• Viewing Serena Version Manager information

• Understanding imported information

• Using DOORS traceability

Importing from Serena Version Manager to DOORS
This operation reads the complete structure of a Serena Version Manager project 
into a DOORS module, creating a DOORS object for each folder, file and 
revision. Key properties, version labels and promotion groups are also imported.
Telelogic DOORS for Serena Version Manager Interface uses the Serena Version 
Manager project root to locate a project. If you want to point to a different 
project, you must change the PVCSRoot entry in your registry. You may need 
to change the value of the PVCSVersion entry to reflect the version of Serena 
Version Manager that you are using (from 6.0. to 6.7).

Importing structures
You can import into an empty module or into a module that already contains 
objects. Each Serena Version Manager project is always imported under its own 
top-level object.
Normally, you maintain your configuration item structure in a special module, 
though you might choose to store information for several projects in the same 
module. If you choose to do this, the new project is imported under a new 
level-one object at the end of the module.
To import from Serena Version Manager:
1. Open the target DOORS module.

2. From the DOORS menu, select Serena Version Manager then 
Synchronize/import.
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The following dialog box is displayed:

3. Enter your username and password, then click OK.

The following dialog box is displayed:

4. Click the plus signs (+) to display more folders or files within a project.

5. Select the project or files you want to import, then click Import. 
One or more command prompt windows (DOS boxes) appear briefly during 
the import, depending on your version of Serena Version Manager. This 
happens when Telelogic DOORS for Serena Version Manager Interface is 
communicating with Serena Version Manager. The command prompt 
windows disappear automatically when the process is complete. 

Note  Command prompt windows will appear briefly whenever 
Telelogic DOORS for Serena Version Manager Interface 
communicates with Serena Version Manager.

When the import is complete, the import report is displayed: 
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Importing from Serena Version Manager to DOORS

This window shows how many new items were created during the import, how 
many items were updated and how many were deleted.
For information on how to use the report window functions, see “Viewing 
Serena Version Manager information,” on page 11.

Updating imported structures 
It is likely that your Serena Version Manager data will continue to evolve after 
you have imported it into DOORS. Telelogic DOORS for Serena Version 
Manager Interface can synchronize existing imported data with the state of the 
Serena Version Manager projects, adding new folders, files, revisions, version 
labels and promotion groups as required.
To do this, select the DOORS module to update and repeat the procedure in 
“Importing structures,” on page 7. This object appears at the top of the 
structure, usually the first object in the module. The following dialog box shows 
how many items have been created or updated: 

If an item has been deleted from the project, the equivalent object in the 
DOORS module has the PVM Deleted attribute set to True. The object has 
not been deleted in order to maintain correct traceability in DOORS.

Imported attributes for structures 

During the import process, Serena Version Manager data is stored as DOORS 
attributes. All Serena Version Manager-related attributes are distinguished by a 
PVM prefix. 
The following attributes are used to store Serena Version Manager properties:

Attribute Description

Object Heading The name of the Serena Version Manager folder or file, or 
the number of the revision.



Importing from Serena Version Manager

10    Using Telelogic DOORS for Serena Version Manager Interface

Telelogic DOORS for Serena Version Manager Interface also imports Serena 
Version Manager labels and promotion groups. These too are stored as DOORS 
attributes and the values are kept with each DOORS object. 
If you have a Serena Version Manager label Release 1, a DOORS attribute of 
type Boolean called PVM Label Release 1 is created. All versions that are 
marked with that label will have the DOORS attribute set to True. A simple 
DOORS filter immediately shows which items belong to which release.
If you have a Serena Version Manager promotion group QA, a DOORS attribute 
of type Boolean called PVM Promo QA is created. When a revision belongs to 
that group, the attribute is set to True.

Object Text The Serena Version Manager check-in comment for 
revisions.

PVM Archive Directory The directory containing the archive.

PVM Archive Name The name of the archive.

PVM Date The date on which the element, version or branch was 
created.

PVM Deleted The date on which the element, version or branch was 
deleted.

PVM Directory The directory maintained by Serena Version Manager that 
corresponds to a folder. This attribute is only used when 
importing from a Serena Version Manager 6.0 database.

PVM Kind Identifies the type of the object. Possible values are 
Project, Folder, File, Label and Revision.

PVM New A boolean attribute that identifies new items added by 
importing or synchronizing data.

PVM Updated The date on which the element, version or branch was 
updated.

PVM User The name of the person who created the file or revision.

PVM Work Directory The directory where the work file is stored for files, or the 
directory where work files are extracted for a folder.

PVM Work File The name of the work file.

Attribute Description
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Viewing Serena Version Manager information

Telelogic DOORS for Serena Version Manager Interface also creates three 
attributes to store import metadata: PVM Deleted, PVM New and PVM 
Updated. These are set each time you import or synchronize and are the basis 
for the import report filters. You can create your own filters and views based on 
these attributes.

Viewing Serena Version Manager information
DOORS provides many useful ways of viewing imported Serena Version 
Manager information. It has the advantage of being able to put all relevant 
information into a single screen, as follows: 

This is particularly useful for any updated information, which is clearly shown 
using the standard DOORS change bars. After an import, new or updated items 
have their change bars set to red, but the rest of the objects remain unchanged. 
For example, in the picture above you can see that one object has recently been 
added.
In the case of a re-import, you can use the New items, Updated items and 
Deleted items buttons in the Serena Version Manager Import Report window 
to show only the items that were new, updated, or deleted, as follows: 
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The following screenshot shows the data with a new or updated filter applied:

Understanding imported information
Serena Version Manager information is imported and turned into normal 
DOORS objects. This section explains how to interpret this information and 
how to get the best from it.

Graphics colors for structures 

When each item is imported, it is assigned a background color, used in graphics 
mode. This helps provide instant visual recognition of the structure of your data.
The color allocations are as follows:

Version labels 

Serena Version Manager version labels are typically used to mark which files were 
included in a particular release. Version labels are supplied when files are checked 
in and are a simple string such as Patch 1.1. The import process creates a 

Type Color

Project Black (no color on normal DOORS background)

Folder Green

File Blue

Revision Light blue
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Using DOORS traceability

Boolean attribute for each label prefixing the label name with PVM Label. For 
this example, the Boolean attribute would be PVM Label Patch 1.1. 
Each version that is labeled with a given name has the DOORS attribute set to 
True. This can be used in filters and gives instant indications of what versions 
were used in a given release.
The following screenshot shows an example of a label filter, set up by filtering on 
PVM Label Release 1.0 equals True: 

Using DOORS traceability 
Once imported into DOORS, the Serena Version Manager structure can be 
treated the same way as normal DOORS objects. This means that they can be 
included in your traceability schema. A typical application of this is to link source 
code modules to requirements in order to check which requirements have been 
met.

Link management
You can use any of the following standard DOORS methods for creating links 
between Serena Version Manager configuration items and other DOORS 
information: 

• Drag and drop 
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• Link > Create links 

• Link module matrix 

In each case you must take the direction of each link into account to enable 
impact and traceability analyses to be performed. These analyses can be 
performed using the following standard tools: 

• Pop-up menus 

• Analysis > Impact or Analysis > Trace 

• Layout DXL 

• Analysis > Wizard 

The last item, the analysis wizard, is particularly good for creating customized 
traceability reports. With this, you could create a report that shows the 
relationship between change requests and code check-ins, showing complete 
version names in the context of the change requests.
Links can be deleted by using any of the standard techniques.

Applications of imported structures 
DOORS can be used to store any kind of structured information, so it is likely 
that you already have information that can be usefully linked to the configuration 
items. In addition to the classic application of requirements traceability, you can 
also build links from change requests, bug reports, design information, test plans 
and project plans to Serena Version Manager versions.
Once in place, you can demonstrate that specific changes have been 
implemented, or create reports that justify all checked-in changes.
Another application is to create complete product manifests. Using the DOORS 
export functions, you can create documents in Microsoft Word, HTML or any 
other supported format, that lists the document version included in a shipment.
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4 Labelling DOORS baselines 
This chapter describes: 

• Importing Serena Version Manager labels into DOORS

• Creating DOORS baselines

• Understanding baseline information

• Using DOORS traceability

Importing Serena Version Manager labels into DOORS 
Serena Version Manager labels are typically used to mark which files were 
included in a particular release. Version labels are specified when revisions of 
files are checked in. 
DOORS baselines create frozen versions of modules that are similar to 
checked-in versions of files: they can be referenced, but not changed. Baselines 
are numbered progressively using major and minor versions, plus an optional 
text suffix. 
Serena Version Manager version labels are ideal for DOORS baseline suffixes, 
where they can be used for the same purpose as in Serena Version Manager. 
Baseline labelling is a two-step process: importing labels from a project module 
and creating baselines. The import process sets up a structure where a record of 
each baseline is kept. This section describes the import step while “Creating 
DOORS baselines,” on page 19 describes baseline creation. 

Importing labels 
You can choose to import version labels into an empty module or into a module 
that already contains objects. The set of labels from each project is always 
imported under its own top-level object. 
Normally you should maintain your label and baseline structure in a special 
module, though you might choose to store label information for several projects 
in the same module. If you choose to do this, the new project will be imported 
under a new level-one object at the end of the module. 
Before using the baseline labelling process you must import the required Serena 
Version Manager project into a DOORS module. The baseline process reads the 
version labels from this module. 
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Note  You must be a DOORS database manager to perform this 
function. It performs irrevocable module baseline 
operations. 

To import labels: 
1. Open your target DOORS module. If the module is not empty, select a 

parent object for your imported structure. 

2. From the DOORS menu, select Serena Version Manager then Label 
baselines. 

The following dialog box is displayed: 

3. Select the DOORS module previously used to import the Serena Version 
Manager project.
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Importing Serena Version Manager labels into DOORS

A dialog box is displayed, with one or more projects in the select box, as 
follows: 

4. Select the project whose labels you want to use.

5. Click Use project to create the module structure. 

When the import is complete, the DOORS module is updated and the 
Apply Label to Modules window appears. For further information, see 
“Creating DOORS baselines,” on page 19. 

The following screenshot shows the label module after importing labels:

Re-importing labels 

After you have completed this baseline labelling operation, you may want more 
Serena Version Manager labels. Telelogic DOORS for Serena Version Manager 
Interface can synchronize existing imported labels with the Serena Version 
Manager project, adding new labels as required.
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To do this, after selecting the project object at the top of the label and baseline 
structure, repeat the procedure in “Importing labels,” on page 15.

Imported attributes for labels 
During the import process, Serena Version Manager data is stored as DOORS 
attributes. All Serena Version Manager-related attributes are distinguished by a 
PVM prefix. 
The following attributes are used to store Serena Version Manager properties:

Attribute Description

Object Heading The name of the Serena Version Manager label.

Object Text The Serena Version Manager comment for the label, 
specified when the label was created.

PVM Kind Identifies the type of the object. Possible values are 
Project, Label and Baseline.

PVM User The name of the person who created the label.

PVM Date The date on which the label was created. 
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Creating DOORS baselines

Creating DOORS baselines
Creating DOORS baselines is the second step of the import process. Baselines 
are created using the following dialog box, which is displayed when the import is 
complete:

To create labeled baselines:
1. Ensure that all needed DOORS modules are closed and not in use by 

anyone else. 

2. Select the required label from the list in Serena Version Manager version 
labels. 

3. Select the required module(s) from the list in DOORS modules. Use Select 
all and Clear all to simplify the selection process. 

4. Select the type of baseline required: Suffix only, Minor version, or Major 
version. 

5. Select whether to include a suffix by clicking Use suffix. The default suffix 
is the selected Serena Version Manager label. You can modify it if required. 
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6. Modify the label comment, if necessary. It is used as annotation for the 
baseline. 

7. Click Baseline. You are asked to confirm the operation, twice. Baseline 
creation requires exclusive, write access to all selected modules. This means 
you must ensure that no one else is using the modules. 

Once a baseline has been created it cannot be destroyed or recreated, so you 
must be absolutely certain that a group baselining operation is correct before 
proceeding.
Baselines are created for each of the specified modules, and the label module is 
updated to contain a baseline-creation object for each module. 
The attribute PVM Baseline is created and filled with the baseline name for 
each baseline-creation object. 
When complete, the following dialog box is displayed, indicating how many 
labels and baselines were created: 

For further information on how to use the window functions, see 
“Understanding baseline information,” on page 20.

Understanding baseline information
All the normal DOORS viewing mechanisms can be used on the label and 
baseline structure. The information can be displayed in either document or 
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Understanding baseline information

graphics mode. Each object type has a color to aid visual identification. The 
following screenshot shows module baseline records created in column view: 

Graphics colors for labels 

When each item is imported, it is assigned a background color that is used in 
graphics mode. This helps provide instant visual recognition of the structure of 
your data. 
The color allocations are as follows:

Viewing new baseline information 
If you re-import labels or create new labels in the same module, you can use the 
Baseline Labelling Report window’s Apply filter button to show only the 
newly-created items. 

Type Color

Project Black (no color on normal DOORS background)

Label Red

Baseline Blue
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The following dialog box is displayed: 

Click Apply filter. 
The formal module is displayed with the filter applied: 

The following screenshot shows the DOORS Open Baseline dialog box for a 
baseline created using a Serena Version Manager version label: 
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Using DOORS traceability

Using DOORS traceability 
By storing information on labels and baselines in a DOORS module, they can be 
included in your traceability schema. In this way you can link details of released 
information directly to project plans and other applications, as outlined below. 

Link management for labels 
You can use any of the following standard DOORS methods for creating links 
between label and baseline objects and other DOORS information:

• Drag and drop

• Link > Create links
• Link module matrix

In each case, you must take into account the direction of links to allow impact 
and traceability analyses to be performed as required. These analyses can be 
performed using the following standard tools:

• Pop-up menus

• Analysis > Impact or Analysis > Trace
• Layout DXL

• Analysis > Wizard
The last item, the analysis wizard, is particularly good for creating customized 
traceability reports. With this, you could create a report that shows the 
relationship between code check-ins and module baselines, showing complete 
version names, baseline specifications and dates in the context of planning 
information.
Links can be deleted using any of the standard techniques.

Applications of imported labels 

DOORS can be used to store any kind of structured information, so it is likely 
that you already have information in your data that can be linked to baseline 
records. You might associate particular module baselines with deliveries made to 
customers, meeting specific requirements.
Another application is to create complete product manifests. Using the DOORS 
export functions, you can create documents in Microsoft Word, HTML or any 
other supported format, that lists the document version included in a shipment.
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5 Contacting support
This chapter contains the following topics:

• Contacting IBM Rational Software Support

• What to do before you contact Support

• Sending an automated problem report form

• Other information

Contacting IBM Rational Software Support
Support and information for Telelogic products is currently being transitioned 
from the Telelogic Support site to the IBM Rational Software Support site. 
During this transition phase, your product support location depends on your 
customer history.

Product support
• If you are a heritage customer, meaning you were a Telelogic customer prior 

to November 1, 2008, please visit the DOORS Support Web site on 
https://support.telelogic.com/doors.

Telelogic customers will be redirected automatically to the IBM Rational 
Software Support site after the product information has been migrated.

• If you are a new Rational customer, meaning you did not have 
Telelogic-licensed products prior to November 1, 2008, please visit the IBM 
Rational Software Support site on 
http://www.ibm.com/software/rational/support/.

What to do before you contact Support
If your site has a designated on-site support person, please contact that person 
before you contact our Support team.
To help our Support team solve your problem, please have the following 
information available:

• Your name, title, company name, e-mail address, fax number and telephone 
number.

• Your support ID and support password.

• The version and build number of DOORS that you’re running.
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To get this information, run DOORS, and click Help > About DOORS.

• The operating system you’re running DOORS on.

• What operating system your DOORS database is running on, if different.

• If you are reporting a new problem, please have a clear statement of the 
problem, including the exact text of any error messages produced by 
DOORS, your operating system, or any other tools that were running when 
the problem occurred.

• If you are calling about a problem you reported earlier, you need the original 
tracking number the Support team assigned to your problem.

• If you want, you can use the automated problem report form. For 
information, see “Sending an automated problem report form,” on page 26.

The support center on our web site is at https://support.telelogic.com.

Sending an automated problem report form
To send an automated problem report to Support:
1. Select Help > Generate Support Request.

The Telelogic Support Information dialog box is displayed with some of 
your product information automatically included.

Review the information to make sure it’s accurate.

2. From the Impact drop down list box, select the severity of the problem.

3. In the Summary box, summarize the problem.

4. In the Problem box, type a detailed description of the problem.

5. If available, attach a snapshot.

Click either DOORS Window Snapshot or Screen Snapshot, whichever is 
applicable, and select the snapshot from your machine.

6. If possible, use the buttons in the Attachment Information area to add 
video capture, system details and files.

Note  The Add Product Files button is unavailable in 
DOORS. Product information is collected and added 
automatically.

Add any relevant information to help Support resolve the problem.

7. You can either:
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Sending an automated problem report form

• Display the information you’ve entered in a new window so that you can 
copy it. For example, you may want to add this information to someone 
else’s information. 

Click Just Text (No Email).
• Open the email to edit it before sending it to Support. 

Click Preview and Send to submit the report.

Guidelines for writing a problem report

• Be as specific as possible when you summarize the problem in the 
Summary box and when you explain the situation and provide details in the 
Problem box. For example, “The system crashed when I tried to add an 
attribute” is more helpful than “It crashed.”

• Indicate if there were any system changes, such as customizations or 
upgrades, before the problem occurred.

• If the problem is reproducible, list the specific steps to be followed in order 
to demonstrate the problem and also indicate the model you are using to 
perform the steps.

• In the problem description, include anything different or unusual that you 
observed before the problem happened.

• Make screen captures of anything that you feel will help and attach them to 
the problem report.

• Include any error messages and code samples you have related to the 
problem.

• If you have multiple unrelated questions or issues, please submit them 
separately. 

Automatic responses and recording defects

When you send the online form to Support, the customer service system 
immediately searches the Knowledge Base based on the Summary and 
Problem descriptions you entered. If there is an exact match of your problem in 
the knowledge base, the system automatically sends an email to you with a 
pointer to the most likely solution.
The problem is also automatically recorded in the defect tracking system as 
assigned to a support representative. This representative works with you to be 
certain that your problem is solved. The defect tracking system also records new 
problems with their solutions in the Knowledge Base to provide rapid assistance 
for other customers.
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Automatically generated problem reports

If your DOORS system crashes, it displays a message asking if you want to send 
a problem report about the crash to DOORS Support.
If you decide to send this generated report, the system displays the same online 
form that is available from Help > Generate Support Request. In this case, 
the form contains information about the crash condition, in addition to the 
information that is usually filled in describing your system. 
Add any more information that you can to help the Support staff identify the 
problem before you click the Preview and Send button.

Changing the email address of the problem report
If you want to send the problem to someone other than DOORS Support, for 
example to your internal support, you can change the default email address of 
the problem report.
To change the email address of the problem report:
1. Open System in the Control Panel.
2. On the Advanced tab, click Environment Variables, then click New under 

variables.

The New User Variable window is displayed

3. In Variable Name enter ILX_RECIP, the variable that controls the 
address used by the problem report.

4. In Variable Value enter the email address you want to use.

5. Click OK to add the value.
6. Click OK to save the value in the environment variables.
7. Click OK to save the value in the system properties.

Other information
For Rational software product news, events, and other information, visit the 
IBM Rational Software Web site on http://www.ibm.com/software/rational/.
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6 Notices
This information was developed for products and services offered in the U.S.A. 
IBM may not offer the products, services, or features discussed in this document 
in other countries. Consult your local IBM representative for information on the 
products and services currently available in your area. Any reference to an IBM 
product, program, or service is not intended to state or imply that only that IBM 
product, program, or service may be used. Any functionally equivalent product, 
program, or service that does not infringe any IBM intellectual property right 
may be used instead. However, it is the user's responsibility to evaluate and verify 
the operation of any non-IBM product, program, or service. 
IBM may have patents or pending patent applications covering subject matter 
described in this document. The furnishing of this document does not grant you 
any license to these patents. You can send written license inquiries to:  
 
IBM Director of Licensing 
IBM Corporation 
North Castle Drive 
Armonk, NY 10504-1785 
U.S.A.  
 
For license inquiries regarding double-byte character set (DBCS) information, 
contact the IBM Intellectual Property Department in your country or send 
written inquiries to:  
 
IBM World Trade Asia Corporation 
Licensing 
2-31 Roppongi 3-chome, Minato-ku 
Tokyo 106-0032, Japan  
 
The following paragraph does not apply to the United Kingdom or any 
other country where such provisions are inconsistent with local law: 
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES 
THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
Some states do not allow disclaimer of express or implied warranties in certain 
transactions. Therefore, this statement may not apply to you. 
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This information could include technical inaccuracies or typographical errors. 
Changes are periodically made to the information herein; these changes will be 
incorporated in new editions of the publication. IBM may make improvements 
and/or changes in the product(s) and/or the program(s) described in this 
publication at any time without notice. 
Any references in this information to non-IBM Web sites are provided for 
convenience only and do not in any manner serve as an endorsement of those 
Web sites. The materials at those Web sites are not part of the materials for this 
IBM product and use of those Web sites is at your own risk. 
IBM may use or distribute any of the information you supply in any way it 
believes appropriate without incurring any obligation to you. 
Licensees of this program who wish to have information about it for the 
purpose of enabling: (i) the exchange of information between independently 
created programs and other programs (including this one) and (ii) the mutual use 
of the information which has been exchanged, should contact:  
 
Intellectual Property Dept. for Rational Software 
IBM Corporation 
1 Rogers Street 
Cambridge, Massachusetts 02142 
U.S.A. 
 
Such information may be available, subject to appropriate terms and conditions, 
including in some cases, payment of a fee. 
The licensed program described in this document and all licensed material 
available for it are provided by IBM under terms of the IBM Customer 
Agreement, IBM International Program License Agreement or any equivalent 
agreement between us. 
Any performance data contained herein was determined in a controlled 
environment. Therefore, the results obtained in other operating environments 
may vary significantly. Some measurements may have been made on 
development-level systems and there is no guarantee that these measurements 
will be the same on generally available systems. Furthermore, some 
measurements may have been estimated through extrapolation. Actual results 
may vary. Users of this document should verify the applicable data for their 
specific environment. 
Information concerning non-IBM products was obtained from the suppliers of 
those products, their published announcements or other publicly available 
sources. IBM has not tested those products and cannot confirm the accuracy of 
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Trademarks

performance, compatibility or any other claims related to non-IBM products. 
Questions on the capabilities of non-IBM products should be addressed to the 
suppliers of those products.
This information contains examples of data and reports used in daily business 
operations. To illustrate them as completely as possible, the examples include the 
names of individuals, companies, brands, and products. All of these names are 
fictitious and any similarity to the names and addresses used by an actual 
business enterprise is entirely coincidental. 
If you are viewing this information softcopy, the photographs and color 
illustrations may not appear. 
Additional legal notices are described in the legal_information.html file that is 
included in your software installation.

Trademarks

IBM, the IBM logo, ibm.com, Telelogic, Telelogic DOORS, and Telelogic 
DOORS for Serena Version Manager Interface are trademarks or registered 
trademarks of International Business Machines Corporation in the United States, 
other countries, or both. These and other IBM trademarked terms are marked on 
their first occurrence in this information with the appropriate symbol (® or ™), 
indicating US registered or common law trademarks owned by IBM at the time 
this information was published. Such trademarks may also be registered or 
common law trademarks in other countries. A current list of IBM trademarks is 
available on the Web at www.ibm.com/legal/copytrade.html.
Microsoft, Windows and/or other Microsoft products referenced herein are 
either trademarks or registered trademarks of Microsoft Corporation.
Other company, product or service names may be trademarks or service marks 
of others.
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